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Cisco Unified Presence Releas
C H A P T E R 1

Cisco Unified Presence のインストール準備

• 「Cisco Unified Presence インストールの前提条件について」（P.1）

• 「VMware Server に Cisco Unified Presence をインストールする際の前提条件について」（P.5）

• 「インストール前タスクの実行」（P.8）

• 「参考情報の入手」（P.9）

Cisco Unified Presence インストールの前提条件について
ここでは、Cisco Unified Presence のインストールに関して最もよく寄せられる質問について説明し、

ネットワークに Cisco Unified Presence をインストールする前に確認が必要な情報を示します。円滑に

設定するには「準備チェックリスト」を使用して、インストール前に必要な情報をすべて収集してくだ

さい。

関連項目

付録 A「インストール準備チェックリスト」

• 「必要なパスワード」（P.2）

• 「サポートされるサーバ」（P.3）

• 「ブリッジのアップグレード」（P.4）

• 「サポートされるブラウザ」（P.4）

• 「ソフトウェアの制限事項」（P.4）
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第 1 章      Cisco Unified Presence のインストール準備

    Cisco Unified Presence インストールの前提条件について
必要なパスワード

Cisco Unified Presence のインストール中に、次のユーザ名とパスワードを指定する必要があります。

パスワードの種類 説明 トラブルシューティングのヒント

管理者アカウント 次のインターフェイスにログインするに

は、管理者のユーザ ID とパスワードを

作成する必要があります。

• Cisco Unified Operating System の
管理インターフェイス

• Disaster Recovery System の管理イ

ンターフェイス

• コマンドライン インターフェイス

（CLI）

• 管理者ログインは、先頭がアル

ファベットで 6 文字以上必要で

す。英数字、ハイフン、および

アンダースコアを使用できます。

• 管理者のパスワードを紛失して

システムにアクセスできない場

合は、Cisco Unified 
Communications Operating 
System の管理ページで、管理

者パスワードを復旧できます。

• 管理者パスワードのリセットが

必要な場合は、CLI を使用しま

す。必要な CLI の構文について

は、このガイドの付録にある

「インストール準備チェックリ

スト」を参照してください。
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第 1 章      Cisco Unified Presence のインストール準備

    Cisco Unified Presence インストールの前提条件について
サポートされるサーバ

Cisco Unified Presence をインストールする前に、次の手順に従ってください。

• 使用するハードウェアを確認し、サーバがサポートされていることを確認する必要があります。

Cisco Unified Presence のリリースをサポートしているサーバについては、次の URL にある

『Hardware and Software Compatibility Information for Cisco Unified Presence』を参照してください。

http://www.cisco.com/en/US/products/ps6837/products_device_support_tables_list.html

• ネットワークで Cisco Unified Presence マルチノード機能を設定する場合は、次の URL にある

『Deployment Guide for Cisco Unified Presence』のマルチノード ハードウェアの推奨事項、および

インストールとアップグレード情報を参照してください。

http://www.cisco.com/en/US/products/ps6837/products_installation_and_configuration_guides_list
.html

アプリケーション 
ユーザ アカウント

Cisco Unified Presence の管理インター

フェイスにログインするには、アプリ

ケーション ユーザ ID とパスワードを作
成する必要があります。

アプリケーション ユーザ パスワー

ドのリセットが必要な場合は、CLI 
を使用します。必要な CLI の構文に

ついては、このガイドの付録にある

「インストール準備チェックリスト」

を参照してください。

セキュリティ パス

ワード

インストールする 
Cisco Unified Presence サーバ用に、
Cisco Unified Communications Manager 
からセキュリティ パスワードを取得す
る必要があります。

Cisco Unified Presence に設定するセ

キュリティ パスワードは、Cisco 
Unified Communications Manager 
Publisher サーバで使用されるパスワー

ドと同一にする必要があります。

• Cisco Unified Communications 
Manager のセキュリティ パス

ワードを紛失した場合は、
Cisco Unified Communications 
Manager サーバでパスワードを

確認できません。

• インストール後の導入ウィザー

ドで、Cisco Unified 
Communications Manager セ
キュリティ パスワードをリセッ

トできます。このウィザード

は、Cisco Unified Presence の
管理機能に初めてログインした

ときに表示されます。

• Cisco Unified Presence の管理

ページに初めてログインした後
に Cisco Unified 
Communications Manager セ
キュリティ パスワードをリセッ

トするには、

Cisco Unified Presence の管理

ページで [システム（System）] 
> [CUCM パブリッシャ

（CUCM Publisher）] の順に選

択します。

パスワードの種類 説明 トラブルシューティングのヒント
1-3
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第 1 章      Cisco Unified Presence のインストール準備

    Cisco Unified Presence インストールの前提条件について
ブリッジのアップグレード

Cisco Unified Presence Release 8.0 では次のハードウェアがサポートされません。

• MCS-7825-H1-IPC1

• MCS-7825-I1-IPC1 

• MCS-7835-H1-IPC1 

• MCS-7835-I1-IPC1 

• MCS-7845-H1-IPC1 

• MCS-7845-I1-IPC1

Cisco Unified Presence には、ここにリストされている製造中止となったハードウェアからサポート対

象のハードウェアへの移行を希望するお客様に、ブリッジ アップグレードが用意されています。ブ

リッジ アップグレードにより、製造中止となったハードウェアに DRS バックアップを作成できるよう

になります。Cisco Unified Presence をサポート対象ハードウェアに新規インストールした後で、この 
DRS バックアップをサポート対象ハードウェアに復元できます。

ここにリストされている製造中止となったハードウェアでアップグレードしようとすると、

Cisco Unified Presence はインターフェイスと CLI に警告を表示します。また、

Cisco Unified Presence では、サーバでの DRS バックアップの作成機能だけがサポートされているこ

とが通知されます。

関連項目

• 『Disaster Recovery System Administration Guide』

サポートされるブラウザ

Cisco Unified Presence の管理ページ、Cisco Unified Serviceability、および Cisco Unified 
Communications Operating System の管理ページの各インターフェイスにアクセスするには、

Microsoft Internet Explorer バージョン 6.0 以降あるいは Mozilla Firefox バージョン 3.0 以降を使用す

る必要があります。

ソフトウェアの制限事項

Cisco Unified Presence は、シスコシステムズが承認したソフトウェアだけをアップロードおよび処理で

きます。サードパーティの Linux または Windows ベースのソフトウェア アプリケーションを、Cisco 
Unified Presence にインストールしたり使用することはできません。Cisco Unified Operating System の管

理ページで、有効なソフトウェアのインストールおよびアップグレードを実行してください。
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第 1 章      Cisco Unified Presence のインストール準備

    VMware Server に Cisco Unified Presence をインストールする際の前提条件について
VMware Server に Cisco Unified Presence をインストー
ルする際の前提条件について

• 「VMware のソフトウェア要件」（P.5）

• 「VMware のハードウェア要件」（P.5）

• 「サポートされる VMware の設定」（P.5）

• 「VMware 機能のサポート」（P.6）

• 「VMware のライセンス要件」（P.6）

• 「VMware インストールの例外事項」（P.7）

• 「Cisco UCS B シリーズ ブレード サーバへの移行」（P.7）

• 「OVF テンプレートのインポート」（P.8）

VMware のソフトウェア要件

VMware のソフトウェア要件は次のとおりです。

• Cisco Unified Presence Release 8.0 

• VMware ESXi Release 4.0

（注） VMware 上で Cisco Unified Presence を実行するには、ESX ではなく ESXi を使用するようにしてくだ

さい。ただし、ブレード サーバは VMware ESX クラスタの一部にすることができます。

「サポートされる VMware の設定」（P.5） に記載されているサポート対象の VMware 仕様のいずれかを

使用すると、Cisco Unified Presence Release 7.0(5) 以降から Cisco Unified Presence Release 8.0 に 
VMware 上でアップグレードできます。

VMware のハードウェア要件

Cisco Unified Presence は、Cisco UCS B シリーズ ブレード サーバだけで VMware をサポートします。

Media Convergence Server（MCS）から Cisco UCS B シリーズ ブレード サーバでの VMware 上への 
Cisco Unified Presence の移行に関する詳細については、「Cisco UCS B シリーズ ブレード サーバへの

移行」（P.7） を参照してください。

サポートされる VMware の設定

表 1-1 に、VMware サーバ上の Cisco Unified Presence の推奨（最小）仕様を示します。

表 1-1 VMware の推奨仕様

ユーザ vCPU RAM vDisk
仕様 1： 2500 2 4 GB 1 x 80GB

仕様 2： 5000 4 4 GB 2 x 80GB
1-5
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第 1 章      Cisco Unified Presence のインストール準備

    VMware Server に Cisco Unified Presence をインストールする際の前提条件について
事前設定された仮想マシンをインポートする場合、シスコでは、事前定義された CPU 情報、ディスク

情報および RAM 情報が含まれる VM 仕様ごとに、OVM テンプレートを提供しています。OVF テン

プレートは Cisco.com からダウンロードする必要があります。Cisco.com の OVF テンプレートの場所

については、『Release Notes for Cisco Unified Presence』を参照してください。

Cisco Unified Presence は、インストール中に、ハードウェア チェックを実行します。このチェックで

は、サポートされる VMware サーバ プラットフォーム タイプを使用しているかどうかと、VMware 
サーバが最小仕様を満たしているかどうかが確認されます。サポートされる VMware 設定を実行して

いない場合、Cisco Unified Presence は、サポート対象の設定ではないことと、この設定を実働環境で

は使用できず、ライセンスも受けられないことを示す警告を表示します。

関連項目

• 『Release Notes for Cisco Unified Presence』

• 「OVF テンプレートのインポート」（P.8）

VMware 機能のサポート

表 1-2 に、Cisco Unified Presence の VMware 機能サポートを示します。

VMware のライセンス要件

VMware サーバで実行される Cisco Unified Presence のライセンスを取得するには、サーバのライセン

ス MAC 値が必要です。[Cisco Unified OS の管理（Cisco Unified OS Administration）] > [表示

（Show）] > [システム（System）] の順に選択するか、[表示（Show）] > [ネットワーク（Network）] 
の順に選択して、ライセンス MAC 値を表示します。

表 1-2 VMware 機能のサポート

VMware 機能 サポートの有無

VMotion なし

（注） Cisco は VM の終了と、その後の別のブレード 
サーバ でのリブートをサポートします。ブレード 
サーバをメンテナンス モードに設定する場合、こ

れが役立つことがあります。

SVmotion なし

スナップショット なし

Data Recovery Manager なし

Fault Tolerance なし

Consolidated Backup なし

ハイ アベイラビリティ あり

Site Recovery Manager あり

（注） このパラメータに関連付けられたすべてのサーバ

は、同じサーバ エリア ネットワーク（SAN）に配

置されている必要があります。
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第 1 章      Cisco Unified Presence のインストール準備

    VMware Server に Cisco Unified Presence をインストールする際の前提条件について
Cisco Unified Presence ライセンスの取得方法の詳細については、『Deployment Guide for 
Cisco Unified Presence』を参照してください。

Cisco Unified Presence 8.0 でサポートされるハードウェアへのブリッジ アップグレードを実行するに

は、VMware の新規ライセンス MAC 値で、新規サーバおよびソフトウェア バージョン のライセンス 
ファイルを要求する必要があります。これを実行するには、ご使用のライセンスの「rehost」を要請す

る電子メールを licensing@cisco.com まで送信してください。この手順の詳細については、

『Deployment Guide for Cisco Unified Presence』を参照してください。

関連項目

• 「ブリッジのアップグレード」（P.4）

• 『Deployment Guide for Cisco Unified Presence』

VMware インストールの例外事項

Cisco Unified Presence を VMware 仮想マシンにインストールする場合は、Cisco Unified Presence を
物理サーバにインストールする場合と同じ手順に従ってください。ただし、次の例外事項があります。

• インストールに失敗すると、Cisco Unified Presence のインストール ログが VMware サーバのシ

リアル ポートを介してファイルにダンプされます。Cisco Unified Presence のインストール ログは 
USB キーへはダンプできません。シリアル ポートを VMware サーバに設定する必要があります。

具体的には、Cisco Unified Presence が ASCII テキストをダンプできるファイルにシリアル ポー

トをリンクする必要があります。VMware サーバの電源がオフのときに、シリアル ポートを設定

する必要があります。そのため、VMware サーバでこの設定を実施した後で、インストールを開始

するようにしてください。

• Cisco Unified Presence は、VMware サーバでの USB テープ ドライブへのバックアップをサポー

トしません。

Cisco UCS B シリーズ ブレード サーバへの移行

Cisco Unified Presence は、Cisco UCS B シリーズ ブレード サーバ上の VMware をサポートしていま

す。Media Convergence Server（MCS）から Cisco UCS B シリーズ ブレード サーバ上の 
Cisco Unified Presence VMware に移行する場合、次の（高度な）手順を実行してください。

1. Cisco Unified Operating System インターフェイスを使用して、MCS サーバを 
Cisco Unified Presence Release 8.x にアップグレードします。このリリースに関係する特定のアッ

プグレード情報については、リリース ノートを参照してください。

2. MCS サーバで DRS バックアップを実行します。Cisco Unified Presence は、VMware サーバでの 
USB テープ ドライブへのバックアップをサポートしません。

3. OVF テンプレートをインポートして、UCS サーバに仮想マシンを作成します。

4. MCS サーバの電源を切ります。

5. Cisco Unified Presence Release 8.x を仮想マシンにインストールし、DRS の復元を実行して、

MCS サーバからバックアップされたデータをCisco Unified Presence UCS サーバ上の VMware に
復元します。Cisco Unified Presence は、VMware サーバでの USB テープ ドライブの復元をサ

ポートしません。

6. ライセンスの MAC 値を取得し、次に VMware サーバ用に新しいライセンスを要求します。

7. 新しいライセンスをサーバにアップロードします。

8. 無効となった元のライセンス ファイルを手動で削除し、ライセンス マネージャを再起動します。
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第 1 章      Cisco Unified Presence のインストール準備

    インストール前タスクの実行
関連項目

• 『Release Notes for Cisco Unified Presence』

• 『Cisco Unified Operating System Maintenance Guide for Cisco Unified Presence』

• 『Changing the IP Address and Hostname for Cisco Unified Presence』

• 『Disaster Recovery System Administration Guide』

• 「OVF テンプレートのインポート」（P.8）

OVF テンプレートのインポート

開始する前に

Cisco.com での OVF テンプレートの場所のリンクを取得する方法については、『Release Notes for 
Cisco Unified Presence』を参照してください。

手順

ステップ 1 Cisco.com から CUP 2500 user v1 vmv7.ova などの OVF テンプレートをダウンロードします。

ステップ 2 同じコンピュータで vSphere クライアントを実行します。

ステップ 3 [Hosts and Clusters] ウィンドウで、[File] > [Deploy OVF Template] の順に選択します。

ステップ 4 [Deploy from file] を選択します。

ステップ 5 CUP_2500_user_v1.0_vmv7.ova などの以前ダウンロードした OVF テンプレートを参照して選択します。

ステップ 6 [Next] を選択します。

ステップ 7 新たに作成された仮想マシンを右クリックして [Edit Settings] を選択します。

ステップ 8 [Options] > [Boot Options] を選択します。

ステップ 9 [Force BIOS Setup] をオンにします。

ステップ 10 仮想マシンの電源をオンにします。

ステップ 11 [Boot] メニューを選択し、CD-ROM ドライブが最初のドライブとして選択されていることを確認しま

す。F10 を押して起動の順序保存します。

関連項目

• 『Release Notes for Cisco Unified Presence』

• 「サポートされる VMware の設定」（P.5）

インストール前タスクの実行

開始する前に

このガイドの付録を参照してください。付録には、インストール前に収集する情報を記載した準備

チェックリストや、各データ タイプをインストール後に変更可能かどうかの情報があります。この

チェックリストを印刷して設定データを記入し、インストール中に参照することを推奨します。
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    参考情報の入手
関連項目

• 付録 A 「インストール準備チェックリスト」

• 「ブリッジのアップグレード」（P.4）

• 『Deployment Guide for Cisco Unified Presence』

参考情報の入手 
インストールのプロセスと前提条件についてよく理解するため、このマニュアルの内容すべてに目を通

すことを強く推奨します。さらなる詳細については、次のCisco Unified Presence に関するガイドを参

照してください。

• Cisco Unified Presence の管理ページのオンライン ヘルプ

Cisco Unified Presence の設定、保守、および管理方法を順を追って説明します。

• 『Hardware and Software Compatibility Information for Cisco Unified Presence』

インストール前のタスク 特記事項

ステップ 1 Cisco Unified Presence サーバが Cisco Unified 
Communications Manager パブリッシャ サーバにネット

ワーク アクセスできることを確認します。

Cisco Unified Communications Manager に、他のサー

バから ping を実行します。

ステップ 2 対応する Cisco Unified Communications Manager サーバ

で Cisco AXL Web Service が起動していることを確認し

ます。

Cisco Unified Serviceability で [Tools] > [Service 
Activation] の順に選択します。

ステップ 3 DNS を使用する場合は、DNS サーバで新しい 
Cisco Unified Presence サーバのホスト名を設定したこ

とを確認します。また、DNS サーバが、Cisco Unified 
Communications Manager パブリッシャ サーバのホスト

名、および他のCisco Unified Presence サーバ（存在す

る場合）のホスト名を解決できることを確認します。

注意 Cisco Unified Presence と Cisco Unified 
Communications Manager で同じ DNS サー

バを使用することを推奨します。異なる 
DNS サーバを使用すると、システムの動作

に異常が発生する場合があります。

Cisco Unified Presence でマルチノード機能

を使用する場合は、DNS 設定オプションに

ついて『Deployment Guide』を参照してくだ

さい。

ステップ 4 Cisco Unified Presence 新規インストール後に、システ

ムはデフォルトで 90 日間の評価モードになります。

Cisco Unified Presence を実稼動モード（試行版の評価

期間の終了前または終了後）に移行できるようにするに

は、まず Cisco Unified Presence の新規インストールに

ついて正しいサーバ ライセンスを取得する必要がありま

す。サーバ ライセンスは、Cisco Unified Presence サー

バをサポートし、Presence Engine およびプロキシ サー

ビスのサービス アクティベーションを可能にします。

Cisco.com の License Generation Web ツールを使用す

ると、必要な単位数のライセンス ファイルを生成でき

ます。

Cisco Unified Presence ライセンス要件とライセンス取

得の詳細については、『Deployment Guide for Cisco 
Unified Presence』を参照してください。

ステップ 5 Cisco Unified Presence Release 8.0 へのアップグレード

を実行するには、ソフトウェア バージョン（アップグ

レード）ライセンスを取得してください。

これは、Cisco Unified Presence Release 8.0 へのブリッ

ジ アップグレードを実行する場合にも当てはまります。

Cisco Unified Presence ライセンス要件とライセンス取

得の詳細については、『Deployment Guide for Cisco 
Unified Presence』を参照してください。
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第 1 章      Cisco Unified Presence のインストール準備

    参考情報の入手
現在使用している Cisco Unified Presence と互換性のあるハードウェア サーバおよびソフトウェア

について説明しています。

• 『Port Usage Information for Cisco Unified Presence』

Cisco Unified Presence リリースのポート情報について説明しています。

• 『Changing the IP Address and Hostname for Cisco Unified Presence』 

Cisco Unified Presence サーバの IP アドレスまたはホスト名の変更手順について説明しています。

• 『Cisco Unified Operating System Maintenance Guide for Cisco Unified Presence』

ソフトウェアのアップグレード情報、およびオペレーティング システムやコマンドライン イン

ターフェイスを介して利用できるユーティリティについて説明しています。

• 『Deployment Guide for Cisco Unified Presence』

Cisco Unified Presence および Cisco Unified Communications Manager の設定手順の概要について

説明しています。また、Cisco Unified Presence と Microsoft Live Communications Server、
Microsoft Active Directory、および Microsoft Office Communicator との統合に関する情報を記載

しています。また、マルチノードでの導入に対応した戦略、および高可用性のためのシスコの推奨

事項も含まれています。

• 『Serviceability Configuration and Maintenance Guide for Cisco Unified Presence』

Cisco Unified Presence のサービスアビリティについて説明しています。アラーム設定、トレース

設定、およびその他のレポートについても順を追って説明しています。

• 『Disaster Recovery System Administration Guide』

バックアップの設定方法、Cisco Unified Presence データのバックアップ方法、およびデータの復

元方法について説明しています。

• Cisco Unified Communications Manager の詳細については、次の URL を参照してください。
http://cisco.com/en/US/products/sw/voicesw/ps556/tsd_products_support_series_home.html?q=
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Cisco Unified Presence Releas
C H A P T E R 2

Cisco Unified Presence のインストールと
設定 

Cisco Unified Presence インストール全体のプロセスには、サーバのタイプに応じて、サーバ 1 台あた

り 45 分から 120 分を要します（インストール前後の作業を除く）。

Cisco Unified Presence は、サーバにプレインストールされている場合もあります。インストール中

に、基本インストールまたは最新のサービス リリースへのアップグレードを実行できます。ソフト

ウェアのインストール開始後、次の表に示すオプションのいずれかを選択する必要があります。

（注） インストール中に表示されるウィンドウの情報については、Space バーを押して [ヘルプ（Help）] を
選択してください（可能な場合）。

• 「Cisco Unified Presence のインストールおよび設定方法」（P.2）

• 「Cisco Unified Presence の無人インストール用応答ファイルの使用」（P.7）

• 「既存インストール データの Cisco Unified Presence へのアップロード」（P.9）

インストール オプション 説明

インストール前 Cisco Unified Presence サーバにソフトウェアがプレインストールされてい

る場合、インストール ディスクは不要です。インストール ルーチンは、基

本インストールと同様に実行されます。ただしインストール ウィザードで

はインタラクティブに設定データの入力を求めるプロンプトが表示され、

入力を処理するために設定ステップが一時停止します。

基本インストール Cisco Unified Presence の基本インストールを表します。インストール 
ディスクからソフトウェアをインストールします。

追加リリース システムを設定する前に、インストール ディスクに含まれているソフト

ウェアのバージョンを最新のサービス リリースにアップグレードできます。

（注） このアップグレード オプションの使用は推奨しません。このパッチ

方式での Cisco Unified Presence の最新リリースへのアップグレー

ドが必要になることはほとんどありません。アップグレードが必要

な場合は、実行する前に「付録 B」を参照してください。
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第 2 章      Cisco Unified Presence のインストールと設定

    Cisco Unified Presence のインストールおよび設定方法
Cisco Unified Presence のインストールおよび設定方法
• 「基本インストールの開始」（P.2）

• 「基本インストールの設定」（P.4）

• 「Cisco Unified Presence パブリッシャ サーバでのシステム時刻の設定」（P.6）

基本インストールの開始

開始する前に

• 「インストール準備チェックリスト」に記載されている、Cisco Unified Presence インストールの前

提条件および必要な作業を完了してください。

• 新しいサーバに Cisco Unified Presence がプレインストールされている場合は、その後の製品リ

リースでサーバを再イメージ化する場合を除いて、DVD からインストールする必要はありません。

既存のインストール データの入力に進んでください。

手順

ステップ 1 インストール DVD をトレイに挿入し、サーバを再起動して DVD から起動します。

ステップ 2 サーバのブート シーケンスの完了後、[Yes] を選択すると、メディア チェックが実行されます。

ステップ 3 メディア チェックの完了後、[Media Check Result] ウィンドウで次のいずれかの操作を実行します。

ステップ 4 [OK] を選択してCisco Unified Presence をインストールします。

次に、インストール プロセスは RAID 設定および BIOS 設定を確認します。インストール プロセス中

にハードウェア設定を変更した場合、システムを再起動するようにプロンプトが表示されます。

Vmware サーバに Cisco Unified Presence をインストールする場合、このチェックは行われません。

メディア チェッ

クの結果 操作 結果

成功 [OK] を選択して、インストー

ルを続行します。

[OK] を選択すると、システム インストーラはさまざまなハードウェア 
チェックを実行し、システムが Cisco Unified Presence 用に正しく設定

されているかを確認します。

– まず、インストール プロセスとしてドライバが正しいことを確

認します。次の警告が表示されることがあります。

「Drivers not found, do you want to install manually?」

インストールを続行するには、[Yes] をクリックします。

– 次に、サポートされるハードウェア プラットフォームが存在す

るかどうかを確認します。サーバがハードウェア要件を完全に

は満たしていない場合、インストール プロセスは致命的なエ

ラーで失敗します。このインストールの失敗が誤りであると思

われる場合はエラーをキャプチャし、シスコのサポートに報告

してください。

ハードウェア チェックが完了すると、[Product Deployment Selection] 
ウィンドウが表示されます。

失敗 次の操作を実行します。

a. もう一度 Cisco.com から

ダウンロードするか、シス

コから別のディスクを直接

入手してください。

b. [OK] を選択して、インス

トールを続行します。
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ステップ 5 [Proceed with Install] ウィンドウで、次のいずれかの操作を実行します。

a. インストールを続行するには、[Yes] を選択します。

b. インストールをキャンセルするには、[No] を選択します。

注意 インストールの続行に問題がないことを確認できるまでは、[Yes] を選択しないでください。[Proceed 
with Install] ウィンドウで [Yes] を選択した場合、ハード ドライブに存在するすべてのデータが上書きさ

れ破棄されます。[Proceed with Install] ウィンドウに、ハード ドライブにある Cisco Unified Presence ソ
フトウェアのバージョン（存在する場合）、および DVD のバージョンが表示されます。

ステップ 6 [Platform Installation] ウィンドウで、次のいずれかの操作を実行します。

ステップ 7 [Apply Patch] ウィンドウで、次のいずれかの操作を実行します。

ステップ 8 [Basic Install] ウィンドウで [Continue] を選択します。

関連項目

• 付録 A 「インストール準備チェックリスト」

• 付録 A 「RAID および BIOS 設定」

• 付録 B 「Cisco Unified Presence ソフトウェアの最新リリースへのアップグレード」

次の手順

• 「基本インストールの設定」（P.4） または

• 「既存インストール データの Cisco Unified Presence へのアップロード」（P.9）

目的 操作

この時点でソフトウェアのインストール

と設定を行う

a. [Proceed] を選択します。

b. ステップ 7 に進みます。

ソフトウェアを今インストールし、設定

は後で行う 
a. [Skip] を選択します。

b. 既存のインストール データの入力に進んでくださ

い。システムが再起動します。

目的 操作

最新リリースにアップグレードせずに、

DVD のソフトウェアをインストールする

[No] を選択します。

ソフトウェアの最新リリースにアップグ

レードする

a. [Yes] を選択します。

b. 最新のソフトウェア リリースへのアップグレード

に進みます。

（注） このアップグレード オプションの使用は推奨し

ません。この方式での Cisco Unified Presence 
の最新リリースへのアップグレードが必要にな

ることはほとんどありません。
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基本インストールの設定

開始する前に

• 前の項で説明したとおり、Cisco Unified Presence DVD をロードして基本インストールを開始し

ます。

• Cisco Unified Presence の設定はインストール要件に固有で、一部のフィールドはオプションです。

たとえば、固定 IP アドレス値と DNS を DHCP で設定できます。

手順

ステップ 1 [Timezone Configuration] ウィンドウで、↑キーまたは↓キーを使用して次の手順に従います。

a. サーバの適切な時間帯を選択します。

b. [OK] を選択します。

ステップ 2 [Auto Negotiation Configuration] ウィンドウで、次のいずれかの操作を実行します。

ステップ 3 最大転送単位（MTU）の値を次のように設定します。

目的 操作

自動ネゴシエーションを使用して、ネットワーク 
インターフェイス カード（NIC）の速度および

デュプレックスを自動的に設定する

[Yes] を選択します。

（注） このオプションを使用するには、ハブま

たはイーサネット スイッチが自動ネゴシ

エーションをサポートしている必要があ

ります。

自動ネゴシエーションを無効にする a. [No] を選択します。

b. [Duplex Configuration] ウィンドウで、次の

操作を実行します。

– 手動で、NIC の適切な速度およびデュプ

レックス設定を選択します。

– [OK] を選択して続行します。

目的 操作

MTU サイズをデフォルトの OS 設定のままにし

て変更しない

[No] を選択します。

MTU サイズをデフォルトの OS 設定から変更す

る

[Yes] を選択します。

（注） Cisco Unified Presence のこの値を変更す

る場合は、Cisco Unified Communications 
Manager の値と同一にする必要がありま

す。これらの値が同一でない場合は、イン

ストールに失敗します。
2-4



 

第 2 章      Cisco Unified Presence のインストールと設定

    Cisco Unified Presence のインストールおよび設定方法
ステップ 4 [DHCP Configuration] ウィンドウで、次のいずれかの操作を実行します。

ステップ 5 固定 IP アドレス値の設定が必要な場合は、[Static Network Configuration] ウィンドウで、次の操作を

実行します。

a. 固定ネットワーク設定値を入力します。

b. [OK] を選択します。

ステップ 6 DNS の設定が必要な場合は、[DNS Client Configuration] ウィンドウで、次の操作を実行します。

a. [Yes] を選択し、DNS クライアント情報を入力します。

b. [OK] を選択します。

ステップ 7 管理者のログイン情報およびパスワード情報を入力します。

ステップ 8 [Certificate Information] ウィンドウで、次の操作を実行します。

a. 証明書署名要求情報を入力します。この情報には、社名、部署名、場所、都道府県、国が含まれま

す。

b. [OK] を選択して続行します。

ステップ 9 インストールするサーバに応じて、次のいずれかの手順を実行します。

関連項目

• 「基本インストールの開始」（P.2）

• 付録 A 「インストール準備チェックリスト」

次の手順

• 「Cisco Unified Presence パブリッシャ サーバでのシステム時刻の設定」（P.6）または 

• 「後続の Cisco Unified Presence サーバのインストールの完了」（P.3）

目的 操作

DHCP を使用する a. [Yes] を選択します。

b. ステップ 7 に進みます。

サーバに固定 IP アドレスを設定する a. [No] を選択します。

b. ステップ 5 に進みます。

サーバ タイプ 操作

パブリッシャ サーバ：ネットワークに最初にイ

ンストールする Cisco Unified Presence サーバ

a. [Yes] を選択します。

b. 「Cisco Unified Presence パブリッシャ サーバ

でのシステム時刻の設定」（P.6） に記載されて

いる Cisco Unified Presence パブリッシャ 
サーバのシステム時刻の設定に進みます。

サブスクライバ サーバ：Cisco Unified Presence 
クラスタ内の後続サーバ

a. [No] を選択します。

b. Cisco Unified Presence パブリッシャ サーバ

での後続の Cisco Unified Presence サーバの

設定に進みます。
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    Cisco Unified Presence のインストールおよび設定方法
Cisco Unified Presence パブリッシャ サーバでのシステム時刻の設定 
開始する前に

• 前の項で示したとおり、基本インストールを開始して設定します。Cisco Unified Presence パブ

リッシャ サーバのインストール時には、ハードウェア クロックを使用して手動でシステム時刻を

設定するか、または最大 5 つの外部 NTP アドレスを割り当てることができます。

• パブリッシャ サーバのシステム時刻を正確に設定するには、Cisco Unified Communications 
Manager パブリッシャだけを NTP サーバとして設定することを推奨します。Cisco Unified 
Communications Manager パブリッシャがクラスタ内の唯一の NTP サーバとして設定されている

と、クラスタ内の後続サーバは Cisco Unified Communications Manager パブリッシャ サーバから

時刻を取得します。

• Cisco Unified Communications Manager パブリッシャは NTP サーバのままにすることを強く推奨

します。それ以外の NTP サーバを使用する場合は、そのサーバが Stratum 9 以上の Stratum 範囲 9
（最下層） ～ 1（最上層） にあることを確認してください。

手順

ステップ 1 [Network Time Protocol Client Configuration] ウィンドウで、次のように正しいシステム時刻を設定し

ます。

ステップ 2 [Security Password] ウィンドウにセキュリティ パスワードを入力します。

設定の対象 操作

外部 NTP サーバ a. [Yes] を選択します。

b. 1 台以上の NTP サーバの IP アドレス、NTP 
サーバ名、または NTP サーバ プール名を入

力します。

（注） ネットワークに DNS が存在しない場合

は、ホスト名を IP アドレスに自動的に解

決することができないため、IP アドレス

を入力する必要があります。

c. インストールを続行するには、[Proceed] を
選択します。

（注） 最大 5 台の NTP サーバを設定できます。3 
台以上使用することを推奨します。システ

ムは NTP サーバに接続して、自動的に

ハードウェア クロックの時刻を設定しま

す。[Test] ボタンが表示されている場合

は、[Test] をクリックして NTP サーバに

アクセスできるかどうかを確認できます。

システム時刻（手動） a. [No] を選択します。

b. 適切な日時を入力して、ハードウェア ク
ロックを設定します。

c. インストールを続行するには、[OK] を選択

します。
2-6



 

第 2 章      Cisco Unified Presence のインストールと設定

    Cisco Unified Presence の無人インストール用応答ファイルの使用
ステップ 3 SMTP ホストを設定する場合は、次の操作を実行します。

a. [Yes] を選択します。

b. SMTP の場所を入力します。

ステップ 4 [Application User Configuration] ウィンドウで、次の操作を実行します。

a. アプリケーション ユーザのユーザ名とパスワードを入力します。

b. [OK] を選択します。

ステップ 5 [Platform Configuration Confirmation] ウィンドウで、次のいずれかの操作を実行します。

a. [OK] を選択して、ソフトウェアのインストールを続行します。[OK] を選択すると、プラット

フォームの設定を変更できなくなります。

b. 設定を変更するには、[Back] を選択します。

ステップ 6 インストール処理が完了すると、管理者のユーザ ID とパスワードを使用してログインするようにプロ

ンプトが表示されます。

トラブルシューティングのヒント

• セキュリティ パスワードは、Cisco Unified Communications Manager パブリッシャのパスワード

と同一にする必要があります。Cisco Unified Presence の管理に初めてログインしたときに、セ

キュリティ パスワードを変更できます。

• 一部のオペレーティング システム機能を使用するには SMTP サーバの設定が必要です。SMTP 
サーバは、Cisco Unified Operating System のインターフェイスまたは CLI を使用して、後で設定

することもできます。

関連項目

• 付録 A 「インストール準備チェックリスト」

次の手順

「Cisco Unified Presence パブリッシャ サーバのインストールの完了」（P.1）

Cisco Unified Presence の無人インストール用応答ファイ
ルの使用

Cisco Unified Presence は、インストール プロセス中に定義済みの設定値を読み取る XML 応答ファイ

ルを使用して、無人インストールを実行できます。

Cisco Unified Communications Answer File Generator は、Cisco Unified Presence の無人インストール

用の応答ファイルを生成する Web アプリケーションです。個々の応答ファイルは、インストール プロ

セス中に、Cisco Unified Presence の DVD に付属の USB キーまたはフロッピー ディスクにコピーさ

れます。

応答ファイルは Cisco Unified Presence のフレッシュ インストールだけに使用可能で、アップグレー

ドには使用できません。Cisco Unified Communications Answer File Generator には、次の URL からア

クセスしてください。

http://www.cisco.com/web/cuc_afg/index.html

この Web アプリケーションでは、次の機能がサポートされています。
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    Cisco Unified Presence の無人インストール用応答ファイルの使用
• パブリッシャ サーバとすべての後続サーバにおける無人インストール用応答ファイルの同時生成

と保存

• データ エントリの構文的な検証

• Internet Explorer バージョン 6.0 以降および Mozilla バージョン 1.5 以降のサポート

• オンライン ヘルプおよびマニュアルの表示

USB キーを Cisco Unified Presence の無人インストールの実行に使用する場合は、必要に応じて、

Windows XP のディスクの管理ユーティリティを使用して USB キーを FAT32 ファイル システムに再

フォーマットします。USB キーの記憶容量が大きく（たとえば 1 GB）、FAT ファイル システムで

フォーマットされている場合は、再フォーマットが必要です。

開始する前に

• この手順を実行するには、管理者または管理者グループのメンバーになることが必要になる場合が

あります。

• DHCP クライアントがパブリッシャ サーバで使用されていて、後続サーバの応答ファイルも生成

されている場合、パブリッシャ サーバの IP アドレスを指定する必要があります。

手順

ステップ 1 Windows XP コンピュータの USB スロットに USB キーを挿入します。

ステップ 2 次の操作を実行します。

a. [スタート（Start）] > [コントロール パネル（Control Panel）] > [管理ツール（Administrative 
Tools）] の順に選択します。

b. [コンピュータの管理（Computer Management）] をダブルクリックします。

ステップ 3 次の操作を実行します。

a. [記憶域（Storage）] ツリーを展開します。

b. [ディスクの管理（Disk Management）] を選択します。

ステップ 4 [リムーバブル ディスク（Removable Disk）] アイコンを右クリックします。

ステップ 5 [フォーマット（Format）] を選択します。

ステップ 6 このパーティションをフォーマットするかどうかの確認を求められたら、[はい（Yes）] をクリックし

ます。

ステップ 7 次の操作を実行します。

a. [ファイル システム（File System）] を選択します。

b. リスト ボックスから [FAT32] を選択します。

ステップ 8 [OK] を選択します。

ステップ 9 ボリュームのフォーマットを確認するプロンプトが表示されたら、もう一度 [OK] を選択します。

次の手順

「既存インストール データの Cisco Unified Presence へのアップロード」（P.9）
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    既存インストール データの Cisco Unified Presence へのアップロード
既存インストール データの Cisco Unified Presence への
アップロード

開始する前に

次の条件に該当する場合は、Cisco Unified Presence 基本インストールの設定をここから開始します。

• 既存のインストール データを応答ファイルにアップロード済みである。

• サーバに Cisco Unified Presence がプレインストールされている。

• Cisco Unified Presence ソフトウェアのインストールを選択したが、設定は後で行うため、プラッ

トフォームのインストール ウィザードのウィンドウで [Skip] を選択した。

手順

ステップ 1 システムの再起動後、[Pre-existing Installation Configuration] ウィンドウが表示されます。

• Answer File Generator で生成された既存の設定情報がフロッピー ディスクか USB キーに格納され

ている場合は、ここでディスクまたは USB キーを挿入して、[Continue] を選択します。インス

トール プロセス中に、設定情報がインストール ウィザードに読み取られます。

ステップ 2 プラットフォームのインストール ウィザードで [Proceed] を選択します。

ステップ 3 [Apply Additional Release] ウィンドウで、次のいずれかの操作を実行します。

ステップ 4 [Basic Install] ウィンドウで [Continue] を選択します。

関連項目

• 付録 B 「Cisco Unified Presence ソフトウェアの最新リリースへのアップグレード」

次の手順

「基本インストールの設定」（P.4）

目的 操作

アップグレードせずにソフトウェアをイ

ンストールする

a. [No] を選択します。

ソフトウェアの最新リリースにアップグ

レードする

a. [Yes] を選択します。

b. 追加リリースの適用に進みます。

（注） このアップグレード オプションの使用は推奨し

ません。このパッチ方式での 
Cisco Unified Presence の最新リリースへのアッ

プグレードが必要になることはほとんどありま

せん。アップグレードする場合は、このオプ

ションを選択する前に、ソフトウェア イメージ

が DVD またはリモート サーバで利用できるか

どうか確認してください。
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Cisco Unified Presence Releas
C H A P T E R 3

パブリッシャ サーバおよび後続サーバでの 
Cisco Unified Presence インストール設定
の完了

• 「Cisco Unified Presence パブリッシャ サーバのインストールの完了」（P.1）

• 「後続の Cisco Unified Presence サーバのインストールの完了」（P.3）

• 「インストール後のチェックリスト」（P.5）

Cisco Unified Presence パブリッシャ サーバのインス
トールの完了

Cisco Unified Presence クラスタ内には「パブリッシャ」は 1 つだけ存在します。このサーバを最初に

インストールします。パブリッシャ サーバを新規インストールした後に一度だけ、Cisco Unified 
Communications Manager パブリッシャの設定、および Cisco Unified Presence パブリッシャ サーバの 
AXL 情報の設定を要求されます。

この情報を設定するため、Cisco Unified Presence の新規インストール後に初めて 
Cisco Unified Presence の管理ページにログインすると、インストール後の導入ウィザードが起動しま

す。

（注） インストール後の導入ウィザードが起動した場合は、初期インストールに成功しています。

開始する前に

• インストール後の導入ウィザードは、Cisco Unified Presence の新規インストールの直後に必ず実

行してください。また、Disaster Recovery System のデータをバックアップまたは復元する前に実

行してください。Cisco Unified Presence をインストールして、インストール後の導入ウィザード

の実行前に Disaster Recovery System のデータをバックアップまたは復元しようとすると、操作に

失敗します。

• インストール後の導入ウィザードは一度しか実行できません。次回、Cisco Unified Presence の管

理ページにログインしたときは、アプリケーションが自動的にインストール後の設定が完了してい

ることを検知し、デフォルトで Cisco Unified Presence の管理ウィンドウが表示されます。

• Cisco Unified Communications Manager パブリッシャの IP アドレスを取得します（DNS を使用し

ていない場合）。Cisco Unified Communications Manager の AXL 権限を持つアプリケーション 
ユーザのユーザ ID を取得します。
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第 3 章      パブリッシャ サーバおよび後続サーバでの Cisco Unified Presence インストール設定の完了

    Cisco Unified Presence パブリッシャ サーバのインストールの完了
手順

ステップ 1 Cisco Unified Presence の管理にログインします。

ステップ 2 次のように、インストール後の導入ウィザードを実行します。

ウィンドウ 設定手順

インストール後の導入ウィ

ザードのウィンドウ

1/5 ページ

a. [ホスト名（Hostname）] フィールドに、Cisco Unified 
Communications Manager パブリッシャのホスト名を入力します。

b. （任意）[IP アドレス（IP address）] フィールドに、Cisco Unified 
Communications Manager パブリッシャの IP アドレスを入力します。

（注） ネットワークに DNS が存在しない場合は、ホスト名を IP ア
ドレスに自動的に解決できないため、IP アドレスを入力する
必要があります。DNS を使用してホスト名を IP アドレスに解
決できる場合は、IP アドレスを空白にできます。アプリケー
ションは自動的に IP アドレスを検出します。

インストール後の導入ウィ

ザードのウィンドウ

2/5 ページ

a. 適切なアプリケーション ユーザのユーザ ID を入力します。この
ユーザには、Cisco Unified Communications Manager パブリッ
シャ サーバに対応した Standard AXL API Access 権限が割り当て
られています。

（注） デフォルトでは、CCMAdministrator ユーザ ID に Standard 
AXL API Access 権限が割り当てられています。

b. AXL パスワードを入力および確認します。

c. [次へ（Next）] を選択します。

インストール後の導入ウィ

ザードのウィンドウ

3/5 ページ

a. Cisco Unified Presence の初期インストール中に入力したセキュ

リティ パスワードを変更および確認入力します。

Cisco Unified Presence の後続サーバをインストールする際には、

これらのサブスクライバ サーバは新規セキュリティ パスワードを

使用し、Cisco Unified Presence パブリッシャ サーバのインス

トール中に使用されたものは使用しないことに注意してください。

b. [次へ（Next）] を選択します。

インストール後の導入ウィ

ザードのウィンドウ

4/5 ページ

設定を確認し、次のいずれかの操作を実行します。

– エラーを修正するには、[戻る（Back）] を選択します。

– 続行するには、[確認（Confirm）] を選択します。

インストール後の導入ウィ

ザードのウィンドウ

5/5 ページ

次のいずれかの操作を実行します。

– Cisco Unified Presence の管理ウィンドウを表示するには、

[ ホーム（Home）] を選択します。

– Cisco Unified Presence のシステム ダッシュボード ウィンド

ウを表示するには、[システム ダッシュボード（System 
Dashboard）] をクリックします。

– システム トポロジ ウィンドウを表示するには、[トポロジ

（Topology）] をクリックします。
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    後続の Cisco Unified Presence サーバのインストールの完了
トラブルシューティングのヒント

• エラー メッセージが表示された場合は、Cisco Unified Communications Manager で AXL が実行さ

れているかどうか、およびユーザ ID とパスワードが正しいかどうかを確認してください。ブラウ

ザを使用して、http://<<CUCM Hostname>>/axl と入力します。ユーザ ID とパスワードを入力す

るようにプロンプトが表示されます。入力した内容が正しければ、Web ページに AXL が実行中

で、要求の受信準備ができていることの確認が表示されます。

• インストール後のウィザードは一度しか実行できません。この初期設定後に Cisco Unified 
Communications Manager パブリッシャのアドレスまたは AXL 情報を変更する場合は、

Cisco Unified Presence の管理で、[システム（System）] > [CUCM パブリッシャ（CUCM 
Publisher）] の順に選択します。

• Cisco Unified Presence の後続サーバは、パブリッシャ サーバの設定チェック後、パブリッシャ 
サーバから Cisco Unified Communications Manager パブリッシャの情報を取得します。

• 製造中止となったハードウェアのアップグレードを実行すると、Cisco Unified Presence から警告

が表示されます。Cisco Unified Presence は、製造中止となったハードウェアからのブリッジ アッ

プグレードをサポートします。ブリッジ アップグレードにより、製造中止となったハードウェア

での DRS バックアップができるようになります。バックアップ後に、サポートされるハードウェ

アで DRS を復元できます。

関連項目

• 『Configuration and Maintenance Guide for Cisco Unified Presence』

• 『Disaster Recovery System Administration Guide』

• 「ブリッジのアップグレード」（P.4）

次の手順

• 「インストール後のチェックリスト」（P.5）

後続の Cisco Unified Presence サーバのインストールの
完了 

この手順は、Cisco Unified Presence クラスタ内の最初のサーバ（パブリッシャ）ではない、後続の

（サブスクライバ）サーバをインストールする場合だけに適用されます（ステップ 9 を参照）。

後続の Cisco Unified Presence サーバをインストールするときは、後続サーバを 
Cisco Unified Presence パブリッシャ サーバと関連付けて、後続サーバのホスト名と IP アドレスを設

定する必要があります。新しいサーバにはそれぞれ、Cisco Unified Presence パブリッシャ サーバへの

ネットワーク アクセスも必要です。

追加の Cisco Unified Presence サーバをインストールする前に、ネットワーク接続性診断ツールを使用

してネットワーク接続性の問題を検査するかどうかを確認するプロンプトが表示されます。システムが 
Cisco Unified Presence でパブリッシャ サーバへのネットワーク アクセスを確認できない場合は、ロ

グを通じて異常点が報告されます。続行する前にサーバの問題を調査する必要がある場合は、設定の途

中でプロセスを一時停止できます。

開始する前に

• Cisco Unified Presence の基本インストールを開始および設定し、クラスタ内に後続サーバをイン

ストールする場合はここから続行します。
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    後続の Cisco Unified Presence サーバのインストールの完了
• Cisco Unified Presence でのパブリッシャ サーバの設定が完了し、インストール後の導入ウィザー

ドが正常に実行されたことを確認します。後続サーバをインストールするときは、「最初のノード」

としてインストールした元のパブリッシャ サーバを考慮してください。

• Cisco Unified Presence でマルチノード機能を使用し、Cisco Unified Presence 後続サーバの追加

を計画している場合、次の作業の実施を推奨します。

– パブリッシャ ノードのトポロジ ビューで後続サーバを追加してから、後続サーバをインス

トールしてください。

– 後続サーバをインストールするまでは、後続サーバをサブクラスタに割り当てないでください。

（注） Cisco Unified Presence パブリッシャ サーバで後続の各サーバを設定するには、

Cisco Unified Presence の管理ページで、[クラスタ（Cluster）] > [トポロジ（Topology）] の順に選

択します。[トポロジ（Topology）] ウィンドウでは、一度に複数の後続サーバを追加できます。たと

えば、パブリッシャ サーバを含めて 6 台のサーバが存在するマルチノード クラスタをインストールす

る場合は、Cisco Unified Presence システム トポロジに、5 台の後続サーバを同時に追加できます。

手順

ステップ 1 [First Node Configuration] ウィンドウで、[OK] を選択して続行します。

ステップ 2 ネットワーク接続性テストの検証が完了してからインストールを続行するには、[No]（デフォルトの

オプション）を選択します。

ステップ 3 パブリッシャ サーバへの正常なネットワーク接続が確認できた場合は、[Continue] をクリックします。

ステップ 4 [First Node Access Configuration] ウィンドウで、次の情報を入力します。

• Cisco Unified Presence パブリッシャ サーバのホスト名

• Cisco Unified Presence パブリッシャ サーバの IP アドレス

• Cisco Unified Presence パブリッシャ サーバにアクセスするためのセキュリティ パスワード

ステップ 5 [OK] を選択して続行します。

ステップ 6 SMTP ホストを設定する場合は、[SMTP Host Configuration] ウィンドウで、次の操作を実行します。

a. [Yes] を選択します。

b. SMTP の場所を入力します。

ステップ 7 [Platform Configuration Confirmation] ウィンドウで、次のタスクを実行します。

a. ソフトウェアのインストールを開始するには、[OK] を選択します。

b. 設定を変更するには、[Back] を選択します。

ステップ 8 インストール処理が完了すると、管理者のアカウントとパスワードを使用してログインするようにプロ

ンプトが表示されます。

トラブルシューティングのヒント

• Cisco Unified Presence に設定するセキュリティ パスワードは、Cisco Unified Communications 
Manager Publisher サーバで使用されるパスワードと同一にする必要があります。

• 後続の Cisco Unified Presence サーバをインストールする前にサブクラスタに割り当てた場合は、

リモート クラスタのユーザがプレゼンス情報を受信できません。サーバがインストールされるま

で、プレゼンス機能は停止します。
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• 一部のオペレーティング システム機能を使用するには SMTP サーバの設定が必要です。SMTP 
サーバは、Cisco Unified Operating System のインターフェイスまたは CLI を使用して、後で設定

することもできます。

• Cisco Unified Presence インストールで複数のサーバを導入する場合は、Cisco Unified Presence 
でマルチノード機能を使用する必要があるため、ハードウェアにマルチノード機能との互換性があ

るかどうか確認してください。Cisco Unified Presence の新規インストールまたはアップグレード

のどちらでも、この作業が必要です。特定のマルチノードの導入戦略、および高可用性を実現する

ための推奨事項については、『Deployment Guide for Cisco Unified Presence』 を参照してください。

関連項目

• 「基本インストールの設定」（P.4）

次の手順

「インストール後のチェックリスト」（P.5）

インストール後のチェックリスト
Cisco Unified Presence クラスタ内にインストールする各サーバで、次の表の手順に示したタスクを実

行します。

注意 ただし、後続の Cisco Unified Presence サーバをインストールする前に、Cisco Unified Presence パ
ブリッシャ サーバに対してインストール後のチェックリストを実行したことを確認してください。

開始する前に

• Cisco Unified Presence パブリッシャ サーバで、インストール後の導入ウィザードを実行し、

Cisco Unified Communications Manager パブリッシャのアドレスおよび AXL パラメータを設定し

ます。

• Cisco Unified Presence の新規インストール直後に、システムはデフォルトで 90 日間の評価モー

ドになります。これは評価用の試用期間です。この期間中は次の操作が可能です。

– 組織にCisco Unified Presence サーバのライセンスがなくても、このサーバの使用または「実

行」が可能

– この組織内のユーザで、Cisco Unified Communications Manager にすでに設定されているユー

ザは、Cisco Unified Presence にアクセスが可能で、Cisco Unified Personal Communicator を
必要なユーザ ライセンス（DLU）がなくても使用できるように設定できる

インストール後のタスク 特記事項

評価用の試用期間が終了する前、または終了

後に、Cisco Unified Presence を実稼動モー

ドに移行するには、あらかじめ取得してある 
Cisco Unified Presence サーバ ライセンス 
ファイルをアップロードしてください。

Cisco Unified Presence の管理ページで、[システム

（System）] > [ライセンス（Licensing）] > [ライセン

ス（License）] > [ファイルのアップロード（File 
Upload）] の順に選択します。

Cisco Unified Communications Manager プ
レゼンス ゲートウェイを設定します。

Cisco Unified Presence の管理ページで、[プレゼンス

（Presence）] > [ゲートウェイ（Gateway）] の順に選

択します。
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Cisco Unified Communications Manager パ
ブリッシャ サーバで Cisco Unified 
Communications Manager を実行している場

合は、次の作業が必要です。

• Cisco Unified Communications Manager 
で SIP パブリッシュ トランクを設定する

• Cisco Unified Presence で SIP パブリッ

シュを有効にする

• Cisco Unified Communications Manager で SIP パ
ブリッシュ トランクを設定する方法については、

『Deployment Guide for Cisco Unified Presence』
を参照してください。

• Cisco Unified Presence で SIP パブリッシュを有

効にするには、Cisco Unified Presence の管理

ページで [プレゼンス（Presence）] > [設定

（Settings）] の順に選択します。

クラスタに後続の Cisco Unified Presence 
サーバを追加する場合は、

Cisco Unified Presence パブリッシャで後続

の各サーバをサーバとして設定した後で、

サーバをインストールしてください。

（注） すべてのサーバを一度に追加できま

す。たとえば、パブリッシャを含め

て 6 台のサーバが存在するマルチ

ノード クラスタをインストールする

場合は、Cisco Unified Presence シス

テム トポロジに、5 台の後続サーバ

を同時に追加できます。

Cisco Unified Presence の管理ページで、[システム

（System）] > [トポロジ（Topology）] の順に選択し

ます。

システム トポロジ内のサーバにユーザを割

り当てます。

ユーザの割り当ては、Cisco Unified Presence の管理

ページのサービス パラメータとして自動的に有効に

なります。ユーザの自動および手動の割り当ての詳細

については、『Deployment Guide for 
Cisco Unified Presence』を参照してください。

次のような、必要な Cisco Unified Presence 
サービスを起動します。

• Cisco UP SIP Proxy

• Cisco UP Presence Engine

• Cisco UP Sync Agent

Cisco Unified Serviceability で [Tools] > [Service 
Activation] の順に選択します。

Cisco UP XCP Router サービスで 
Cisco Unified Presence がオンになっている

ことを確認します。

Cisco Unified Serviceability で、[Tools] > [Control 
Center - Network Services] の順に選択します。

インストール後のタスク 特記事項
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トラブルシューティングのヒント

Cisco Unified Presence サーバを使用する前に、Cisco Unified Presence Sync Agent がアクティブにな

るまで待つ必要があります。

関連項目

• Cisco Unified Presence のライセンス モードの詳細については、『Deployment Guide for Cisco 
Unified Presence』を参照してください。

• RTMT ツールの詳細については、『Serviceability Configuration and Maintenance Guide for Cisco 
Unified Presence』を参照してください。次の URL で入手できます。

http://www.cisco.com/en/US/products/ps6837/prod_maintenance_guides_list.html

バックアップを設定します。

毎日必ず Cisco Unified Presence をバック

アップしてください。

ネットワーク上で Cisco Unified Presence をバック

アップするには、Secure File Transfer Protocol
（SFTP）サーバへのアクセスが必要です。

クラスタ ID を確認します。 複数の Cisco Unified Presence クラスタを導入してい

る場合は、個々のクラスタに固有のクラスタ ID 値が

必要です。Cisco Unified Presence はこのクラスタ ID 
値を使用して、RTMT ツールで送信されたアラート通

知のソース クラスタを識別できます。

インストール時に、システムは固有のクラスタ ID を 
Cisco Unified Presence パブリッシャ ノードに割り当

てます。システムはクラスタ ID を配布して、クラス

タ内のすべてのノードが同じクラスタ ID 値を共有で

きるようにします。

Cisco Unified Presence の管理ページで、[プレゼンス

（Presence）] > [設定（Settings）] の順に選択し、ク

ラスタ ID の表示または設定を行います。

インストール後のタスク 特記事項
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Cisco Unified Presence Release 8.0 イ

A
 P P E N D I X A

インストール準備チェックリストと設定

• 「インストール準備チェックリスト」（P.1）

• 「フィールド定義：インストール準備チェックリスト」（P.5）

• 「RAID および BIOS 設定」（P.8）

• 「Cisco Unified Presence の管理ページにおけるアクセシビリティ設定」（P.9）

インストール準備チェックリスト
Cisco Unified Presence をインストールする前に、クラスタ内でインストールする各サーバの情報を収

集し、作業中に参照できるようにそのデータを印刷してください。表 1 を使用して、必要な情報を記

録します。表の最後のカラムは、インストール後にフィールドを変更できるかどうかを示しています。

変更できる場合は、オペレーティング システムの管理インターフェイスまたはコマンドライン イン

ターフェイス（CLI）のどちらで変更できるかを示しています。

開始する前に

• Cisco Unified Presence サーバが複数存在する場合は、この表をコピーして、サーバごとのエント

リを個別の表に記録してください。

• 値は必ず正確に記入してください。一部のフィールドはインストール後に変更できません。変更す

るには、ソフトウェアの再インストールが必要です。記入する必要がある値が不明な場合は、この

表の次に記載されたフィールドの説明および使用時の推奨事項を参照してください。

• 一部のフィールドは任意です。設定に不要な場合があります。たとえば、SMTP ホストの設定は省

略できる場合があります。

表 1 設定データ

設定データ 入力する値

インストール後に入力値を変更でき

るか

管理者のログイン 不可能

管理者のパスワード 可能

CLI：set password admin
アプリケーション ユーザのユー

ザ名

可能

CLI： 
utils reset ui administrator name
A-1
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アプリケーション ユーザのパス

ワード

可能

CLI： 
utils reset ui administrator 
password

Cisco Unified Communications 
Manager パブリッシャのセキュ

リティ パスワード 

（注） 各 Cisco Unified 
Presence サーバに設定す

るセキュリティ パス

ワードは、Cisco Unified 
Communications 
Manager パブリッシャ 
サーバで使用されるパス

ワードと同一にする必要

があります。

可能

初期インストール中に入力したセ

キュリティ パスワードは、次の 2 つ
の方法のいずれかで変更できます。

• Cisco Unified Presence の管理

ページにあるインストール後

ウィザードでの設定時

Cisco Unified Presence の管理

ページで、[システム（System）] 
> [CUCM パブリッシャ（CUCM 
Publisher）] の順に選択

国 可能

CLI：set web-security [orgunit] 
[orgname] [locality] [state]

DHCP 可能

• Cisco Unified OS の管理ページ

で、[設定（Settings）] > [IP] > 
[パブリッシャ（Publisher）] の
順に選択

• CLI：set network dhcp
プライマリ DNS 可能

CLI：set network dns
セカンダリ DNS 可能

CLI：set network dns
ドメイン 可能

CLI：set network domain
ゲートウェイ アドレス 可能

• Cisco Unified Operating System 
の管理ページで、[設定

（Settings）] > [IP] > [イーサネッ

ト（Ethernet）] の順に選択

• CLI：set network gateway

表 1 設定データ （続き）

設定データ 入力する値

インストール後に入力値を変更でき

るか
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ホスト名

（注） Cisco Unified Presence 
サーバのホスト名を変更

する方法については、

『Changing the IP 
Address and Hostname 
for Cisco Unified 
Presence』を参照してく

ださい。

可能

• Cisco Unified Operating System 
の管理ページで、[設定

（Settings）] > [IP] > [ イーサ

ネット（Ethernet）] の順に選択

• CLI：set network IP

IP アドレス

（注） Cisco Unified Presence 
サーバの IP アドレスを

変更する方法について、

『Changing the IP 
Address and Hostname 
for Cisco Unified 
Presence』を参照してく

ださい。

可能

• Cisco Unified Operating System 
の管理ページで、[設定

（Settings）] > [IP] > [ イーサ

ネット（Ethernet）] の順に選択

• CLI：set network IP

IP サブネット マスク 可能

• Cisco Unified Operating System 
の管理ページで、[設定

（Settings）] > [IP] > [イーサネッ

ト（Ethernet）] の順に選択

• CLI：set IP
Cisco Unified Presence パブ

リッシャ ノードのホスト名

（注） Cisco Unified Presence 
サーバのホスト名を変更

する方法については、

『Changing the IP 
Address and Hostname 
for Cisco Unified 
Presence』を参照してく

ださい。

可能

Cisco Unified Operating System の管

理ページで、[設定（Settings）] > 
[IP] > [パブリッシャ（Publisher）] 
の順に選択

（注） ネットワーク設定の目的で、

Cisco Unified Presence パブ

リッシャ サーバのホスト名を

変更した場合だけに適用され

ます。これを実行する場合は、

Cisco Unified Presence 内の後

続のサーバで、パブリッシャ 
サーバの IP アドレスを更新す

る必要があります。

表 1 設定データ （続き）

設定データ 入力する値

インストール後に入力値を変更でき

るか
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Cisco Unified Presence パブ

リッシャ ノードの IP アドレス

（注） Cisco Unified Presence 
サーバのホスト名を変更

する方法については、

『Changing the IP 
Address and Hostname 
for Cisco Unified 
Presence』を参照してく

ださい。

可能

Cisco Unified Operating System の管

理ページで、[設定（Settings）] > 
[IP] > [パブリッシャ（Publisher）] 
の順に選択

（注） ネットワーク設定の目的で、

Cisco Unified Presence パブ

リッシャ サーバのホスト名を

変更した場合だけに適用され

ます。これを実行する場合

は、Cisco Unified Presence 
内の後続のサーバで、パブ

リッシャ サーバの IP アドレ

スを更新する必要がありま

す。

場所 可能

CLI：set web-security
マスター管理者 ID 不可能

MTU サイズ

（注） この値は、
Cisco Unified 
Communications 
Manager サーバで入力し

た値と同一にする必要が

あります。値が異なる

と、インストールに失敗

します。

可能

CLI：set network mtu

（注） Cisco Unified Presence のこの

値を変更する場合は、Cisco 
Unified Communications 
Manager の値と同一にする必

要があります。

NTP サーバの IP アドレス 可能

Cisco Unified Operating System の管

理ページで、[設定（Settings）] > 
[NTP サーバ（NTP Servers）] の順

に選択

マニュアルの構成 可能

CLI：set web-security
セキュリティ パスワード 可能

CLI：set password security

表 1 設定データ （続き）

設定データ 入力する値

インストール後に入力値を変更でき

るか
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関連項目

• 「フィールド定義：インストール準備チェックリスト」（P.5）

• 『Changing the IP Address and Hostname for Cisco Unified Presence』

フィールド定義：インストール準備チェックリスト 
開始する前に

インストール準備チェックリストを確認します。

SMTP ロケーション 可能

• Cisco Unified Operating System 
の管理ページで、[設定

（Settings）] > [SMTP] の順に選

択し、[SMTP ホスト（SMTP 
Host）] フィールドに IP アドレ

スまたはホスト名を入力

• CLI：set smtp
都道府県 可能

CLI：set web-security
時間帯 可能

CLI：set timezone
部署 可能

CLI：set web-security

表 1 設定データ （続き）

設定データ 入力する値

インストール後に入力値を変更でき

るか
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表 2 に、インストール準備チェックリストに記載されているフィールドの詳細を示します。

表 2 フィールド定義

フィールド 説明 使用法

管理者のログイン 管理者アカウントに割り当てる

名前を指定します。

名前は一意にする必要があります。小

文字、英数字、ハイフン、アンダース

コアを使用できます。先頭は小文字の

英数字にする必要があります。

プラットフォームの CLI または 
Cisco Unified Communications 
Operating System の管理へのログイ

ンに使用するため、この必須フィー

ルドを記録しておく必要があります。

（注） このフィールドはインストー

ル後に変更できません。

管理者のパスワード 管理者アカウントのパスワード

を指定します。

このパスワードは、Cisco Unified 
Communications Operating System 
の管理、Disaster Recovery System、

および CLI へのログインに使用しま

す。

アプリケーション ユーザの

ユーザ名とパスワード

Cisco Unified Presence 管理用

のユーザ名とパスワードを指定

します。

このユーザ ID とパスワードは、

Cisco Unified Presence 管理イン

ターフェイスへのログインに使用し

ます。

DHCP Dynamic Host Configuration 
Protocol; ダイナミック ホスト 
コンフィギュレーション プロト

コル 

DHCP を使用してサーバのネット

ワーク設定を自動的に行うには、[は
い（Yes）] を選択します。

[いいえ（No）] を選択した場合、ホ

スト名、IP アドレス、IP マスク、

ゲートウェイ、および DNS 設定の

入力が必要です。

DNS 有効 DNS（Domain Name System）

サーバは、ホスト名から IP アド

レスまたは IP アドレスからホス

ト名を解決するデバイスを表し

ます。

DNS フィールドは、DHCP を使

用していない場合にだけ表示さ

れます。

DNS サーバを使用しない場合は [い
いえ（No）] を入力します。DNS が
無効の場合、Cisco IP Telephony ネッ

トワークのすべてのネットワーク デ
バイスに対して（ホスト名ではなく）

IP アドレスだけを入力します。

DNS サーバを使用する場合は、[は
い（Yes）] を入力して DNS を有効

にすることを推奨します。DNS を無

効にすると、ドメイン名を解決する

機能が制限されます。
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プライマリ DNS Cisco Unified Presence は、ホ

スト名を解決するとき、最初に

この DNS サーバに接続します。

プライマリ DNS サーバとして指定

する DNS サーバの IP アドレスを入

力します。ddd.ddd.ddd.ddd のドッ

ト付き 10 進表記で IP アドレスを入

力します。ddd の値は、0 ～ 255 で
す（0.0.0.0 を除く）。

DNS を [はい（Yes）] に設定した場

合、このフィールドは必須です。

セカンダリ DNS プライマリ DNS サーバに障害

が発生した場合、

Cisco Unified Presence はセカ

ンダリ DNS サーバに接続を試

みます。

このオプション フィールドに、セカ

ンダリ DNS の IP アドレスを入力し

ます。ddd.ddd.ddd.ddd のドット付

き 10 進表記で IP アドレスを入力し

ます。ddd の値は、0 ～ 255 です

（0.0.0.0 を除く）。

ドメイン このマシンが設置されているド

メインの名前を表します。

DNS を [はい（Yes）] に設定した場

合、このフィールドは必須です。

ゲートウェイ アドレス ゲートウェイは、他のネット

ワークへの入り口として機能す

るネットワーク ポイントを表し

ます。発信パケットは、ゲート

ウェイに送信され、最終宛先に

転送されます。

ddd.ddd.ddd.ddd 形式でゲートウェ

イ IP アドレスを入力します。ddd の
値は、0 ～ 255 です（0.0.0.0 を除

く）。

ゲートウェイがない場合も、この

フィールドに 255.255.255.255 を設

定する必要があります。ゲートウェ

イがない場合、同じサブネット内の

デバイスとだけ通信できます。

ホスト名 ホスト名は、ホストを指定する 
IP アドレスに割り当てられてい

るエイリアスを表します。

ネットワークで一意のホスト名を入

力します。

ホスト名は最大 64 文字で、英数字

とハイフンを使用できます。

DHCP を [いいえ（No）] に設定し

た場合、このフィールドは必須です。

IP アドレス このフィールドには、このマシ

ンの IP アドレスを指定します。

このネットワークのサーバを一

意に識別します。ネットワーク

の他のマシンでは、この IP アド

レスを使用できません。

ddd.ddd.ddd.ddd 形式で IP アドレス

を入力します。ddd の値は、0 ～ 255 
です（0.0.0.0 を除く）。

DHCP を [いいえ（No）] に設定し

た場合、このフィールドは必須です。

表 2 フィールド定義 （続き）

フィールド 説明 使用法
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付録 A      インストール準備チェックリストと設定

    RAID および BIOS 設定
関連項目

• 「インストール準備チェックリスト」（P.1）

RAID および BIOS 設定
ソフトウェアのインストール中に、システム インストーラは新しいオペレーティング システムおよび 
Cisco Unified Presence アプリケーション用に、システム BIOS および RAID を設定します。

IP マスク このフィールドは、このマシン

の IP サブネット マスクを指定

します。サブネット マスクと IP 
アドレスで、ネットワーク アド

レスおよびホスト アドレスを指

定します。

ddd.ddd.ddd.ddd 形式で IP マスクを

入力します。ddd の値は、0 ～ 255 
です（0.0.0.0 を除く）。

有効なマスクは、左側に「1」の

ビットが連続し、右側に「0」の

ビットが連続します。

たとえば、255.255.240.0
（11111111.11111111.11110000.000
00000）は、有効なマスクです。

255.255.240.240
（11111111.11111111.11110000.1111
0000）は、無効なマスクです。

MTU MTU（Maximum Transmission 
Unit）は、このホストがネット

ワークで転送する最大パケット

をバイト単位で表します。

使用するネットワークの MTU サイ

ズをバイト単位で入力します。ネッ

トワークの MTU 設定が不明な場合

は、デフォルト値を使用します。

デフォルト値は 1500 バイトです。

MTU 設定は、クラスタ内のすべて

のノードで同一にする必要がありま

す。

SMTP ロケーション 電子メールの発信に使用する 
SMTP ホストの名前を指定します。

SMTP サーバのホスト名またはドッ

ト付き IP アドレスを入力します。ホ

ストには、英数字、ハイフン、また

はピリオドを使用できます。ホスト

名の先頭は英数字にする必要があり

ます。

電子通知を使用する場合、この

フィールドは必須です。使用しない

場合は空白のままにします。

時間帯 現地時間帯とグリニッジ標準時

（GMT）からのオフセットを示

します。

時間帯を変更する場合は [はい

（Yes）] を選択します。

マシンが設置されている場所に最も

近い時間帯を選択します。

表 2 フィールド定義 （続き）

フィールド 説明 使用法
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付録 A      インストール準備チェックリストと設定

    Cisco Unified Presence の管理ページにおけるアクセシビリティ設定
インストール中に設定される BIOS 設定および RAID 設定については、次の表を参照してください。イ

ンストール中にハードウェア設定プロセスが失敗した場合、IBM サーバおよび HP サーバにあるブー

ト時ユーティリティを使用して、表 3 および 表 4 のように、RAID 設定および BIOS 設定を手動で行

います。

Cisco Unified Presence の管理ページにおけるアクセシビ
リティ設定

Cisco Unified Presence の管理ページおよび Cisco Unified Presence ユーザ オプション ページでは、

ユーザがマウスを使わずにウィンドウでボタンにアクセスするための機能が提供されています。ウィン

ドウの任意の場所から次の手順を実行できるため、ユーザはさまざまなフィールドでのスクロールやタ

ブなどの操作が不要になります。

• 「ウィンドウ内でのアイコンへのアクセス」（P.9）

• 「ウィンドウ内でのボタンへのアクセス」（P.10）

ウィンドウ内でのアイコンへのアクセス

Cisco Unified Presence の多くのウィンドウでは、保存するためのディスクのアイコンや追加を示すプ

ラス（+）記号のアイコンなどが上部に表示されます。

手順

ステップ 1 Alt、1、Tab の順に押します。

表 3 HP サーバおよび IBM サーバの BIOS 設定

HP サーバ IBM サーバ

OS Selection：Linux（新しいモデルには適用さ

れません）

OS Selection：適用されません

Boot order：CD、C:、Floppy Boot order：CD、C:、Floppy
Post F1 prompt：Delayed Post F1 prompt：Delayed
Hyperthreading：Enabled Hyperthreading：Enabled

表 4 RAID 設定

Cisco MCS 7825（HP および 
IBM）

Cisco MCS 7835（HP および 
IBM）

Cisco MCS 7845（HP および 
IBM）

RAID は適用されません 論理ドライブ：1 論理ドライブ：2
RAID は適用されません

（注） Cisco 7825H1 および 
Cisco 7825I1 では、

SATA RAID が有効、

RAID タイプが 1
（1+0）、論理ドライブが 
1 です。

RAID タイプ：1（1+0） RAID タイプ：1（1+0）
A-9
Cisco Unified Presence Release 8.0 インストレーション /アップグレード ガイド



付録 A      インストール準備チェックリストと設定

    Cisco Unified Presence の管理ページにおけるアクセシビリティ設定
ステップ 2 カーソルにより一番左側のアイコンが強調表示されます。次のアイコンへ移動するには、再度 Tab を
押します。

ステップ 3 Enter を押すと、そのアイコンの機能を実行できます。

ウィンドウ内でのボタンへのアクセス

Cisco Unified Presence のウィンドウの多くでは、[保存（Save）] ボタンや [追加（Add）] ボタンな

どが下部に表示されています。

手順

ステップ 1 Alt、2、Tab の順に押します。

ステップ 2 カーソルにより一番左側のボタンが強調表示されます。次のボタンへ移動するには、再度 Tab を押し

ます。

ステップ 3 Enter を押すと、そのボタンの機能を実行できます。
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Cisco Unified Presence Release 8.0 イ

A
 P P E N D I X B

Cisco Unified Presence ソフトウェアの最
新リリースへのアップグレード

（注） ご使用の Cisco Unified Presence サーバが新規にインストールした後に評価モードまたは評価終了モー

ドで動作している場合、アップグレードすることはできません。すでに実稼動している 
Cisco Unified Presence サーバをアップグレードする方法については、『Cisco Unified Operating 
System Maintenance Guide for Cisco Unified Presence』を参照してください。Operating System イン

ターフェイスでソフトウェアのアップグレードを実行するには、[Software Updates] > 
[Install/Upgrade] の順に選択します。特定のリリース情報については、

http://www.cisco.com/en/US/products/ps6837/prod_release_notes_list.html にある『Release Notes for 
Cisco Unified Presence』を参照してください。

Cisco Unified Presence の新規インストール中に [Apply Additional Release] を選択した場合、インス

トール ウィザードはまず DVD のソフトウェア バージョンをインストールし、次にシステムを再起動

します。特定のネットワーク設定パラメータ値およびアップグレード ファイルの場所を入力するよう

に、プロンプトが表示されます。次のいずれかのアップグレード方法を選択します。

– ローカル：CD または DVD からアップグレード ファイルを取得します。

– SFTP：Secure File Transfer Protocol（SFTP）を使用して、リモート サーバからアップグ

レード ファイルを取得します。

– FTP：File Transfer Protocol（FTP）を使用して、リモート サーバからアップグレード ファイ

ルを取得します。

• 「ローカル ディスクからのアップグレード」（P.1）

• 「リモート サーバからのアップグレード」（P.2）

• 「リモート パッチの取得」（P.3）

ローカル ディスクからのアップグレード

開始する前に

ローカル ドライブからアップグレードする前に、適切なパッチ ファイルを Cisco.com からダウンロー

ドし、CD または DVD へファイルをコピーする必要があります。パッチ ファイルのサイズが大きいた

め、ほとんどの場合は DVD にコピーが必要です。

パッチ ファイル名の形式は次のようになります。
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付録 B      Cisco Unified Presence ソフトウェアの最新リリースへのアップグレード

    リモート サーバからのアップグレード
UCSInstall_UCOS_*.sgn.iso

手順

ステップ 1 パッチ ディレクトリおよびパッチ名を必要に応じて入力し、[OK] をクリックします。CD または 
DVD で利用可能なパッチ ファイルがウィンドウに表示されます。

ステップ 2 このパッチでアップグレードするには [Continue] を選択します。システムの再起動後、[Preexisting 
Configuration Information] ウィンドウが表示されます。

トラブルシューティングのヒント

パッチ ディレクトリの入力が必要になるのは、CD または DVD のルート ディレクトリにパッチが保存

されていない場合だけです。

次の手順

「基本インストールの設定」（P.4）

リモート サーバからのアップグレード

開始する前に

リモート サーバへの FTP 接続または SFTP 接続でアップグレードする場合、まずネットワーク設定が

必要です。

手順

ステップ 1 [Auto Negotiation Configuration] ウィンドウで、次のいずれかの操作を実行します。

目的 操作

自動ネゴシエーションを使用して、ネットワーク 
インターフェイス カード（NIC）の速度および

デュプレックスを自動的に設定する

[Yes] を選択します。

（注） このオプションを使用するには、ハブま

たはイーサネット スイッチが自動ネゴシ

エーションをサポートしている必要があ

ります。

自動ネゴシエーションを無効にする a. [No] を選択します。

b. [Duplex Configuration] ウィンドウで、次の

タスクを完了します。

– 手動で、NIC の適切な速度およびデュプ

レックス設定を選択します。

– [OK] を選択して続行します。
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付録 B      Cisco Unified Presence ソフトウェアの最新リリースへのアップグレード

    リモート パッチの取得
ステップ 2 [DHCP Configuration] ウィンドウで、次のいずれかの操作を実行します。

次の手順

「リモート パッチの取得」（P.3）

リモート パッチの取得
手順

ステップ 1 リモート ファイル サーバの場所およびログイン情報を入力します。

ステップ 2 システムがリモート サーバに接続し、利用可能なアップグレード パッチの一覧を取得したら、インス

トールが必要なアップグレード パッチを選択します。パッチをダウンロードし、展開し、インストー

ルします。その後システムを再起動します。

関連項目

「基本インストールの設定」（P.4）

目的 操作

DHCP（Dynamic Host Configuration Protocol）
を使用する

a. [Yes] を選択します。

b. リモート パッチの取得に進みます。

サーバおよびゲートウェイの固定 IP アドレスを

設定する

a. [No] を選択します。

b. [Static Network Configuration] ウィンドウ

で、次の操作を実行します。

– 固定ネットワーク設定値を入力します。

– [OK] を選択します。

c. [DNS Client Configuration] ウィンドウで、

次の処理を実行します。

– [Yes] を選択し、DNS クライアント情報

を入力します。

– [OK] を選択します。
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    リモート パッチの取得
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